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Section 1
Introduction
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t
his software package includes a simple Microsoft( Excel spreadsheet template that looks like the paper version of the Oil Conservation Division’s (OCD’s) C-115 Monthly Production Data Report. The “Add-in” module included with this package processes data from this spreadsheet and creates a “Flat File,” which the operator may then submit to the OCD as an attached file via electronic mail or on a 3.5-inch diskette via U.S. Postal service. 

NOTE:  This reporting package will only work in conjunction with Microsoft( Excel 97 or newer versions.  If you are running a non-supported version of Excel, you will need to upgrade to a more recent version.
Getting Started with C-115 Electronic Filing

Determine which version of Excel you have

Microsoft( Excel’s product information screen will identify which version of Excel you are currently running on your PC.  To access that information, follow these simple steps:
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Start Excel and select “Help” from the pull-down menu.

2. Select the menu item “About Microsoft( Excel” and read the version number that appears in the pop-up window on your computer. Notice the Microsoft( Excel 97 version identifier in the illustration on page 2.  

Determine if you need to upgrade your C-115 software

If you believe you have an older version of C-115 software, check for software upgrades at the “GO-TECH” web site (http://octane.nmt.edu) or contact the Petroleum Recovery Research Center (PRRC) or the OCD office.

Via the Internet:

· Visit http://octane.nmt.edu/gotech/Software/filing.aspx using any standard web browser.  Software can be downloaded from here to your computer.
By Phone or E-Mail:

· Annette Carroll (PRRC) at 505-835-5981 or acarroll@prrc.nmt.edu 

· Martha Cather (PRRC) at 505-835-5685 martha@prrc.nmt.edu
· Jane Prouty (OCD) at 505-827-1109 JPROUTY@state.nm.us 
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Excel’s Version Identifier Screen

Program Installation

BEFORE YOU BEGIN:  Locate the “XLStart” and “Template” folders on your computer.  The C-115 Program Files included in this package must reside within the appropriate folders on your PC in order for the software package to work. For help on Locating Folders on your PC, see page 4 (Using Windows Explorer to Locate Files and Folders.).  See also, Using Windows Explorer to Place Files into Folders using “Copy and Paste” or “Drag and Drop.” 

NOTE:  For Internet Downloads, use a right click of your mouse button to save the files to disk.
Installation from the Internet

Open Internet Explorer or any web browser and go to http://octane.nmt.edu/gotech/Software/filing.aspx .  In the center of your screen appears “C-115 Filing Downloads.”

1. "Download” the Spreadsheet Template (C115Template.xls) to your Template Folder.  
2. Return to your web browser. "Download" the Add-In Filing Module to your root directory (usually C:\), changing the file extension from .xls to .xla as you save it to disk. The file is now saved as C:\C115.xla.
3. Move the Add-in file (C115.xla) from your root directory to your “XLStart Folder.” 
Installation from Diskette

1.  Insert the C-115 Program diskette into Drive A:\. This diskette contains two files:

· C115.xla  (Add-in file for processing C-115 reports; allows you to create an electronic reporting file that is suitable for submission to the OCD) and

· C115Template.xls  (Spreadsheet file closely resembling the C-115 paper copy).
2.  Copy the Add-in file (C115.xla) from the diskette to your “XlStart” Folder.

3.  Copy the C115Template.xls file from the diskette to your “Template” Folder.

Finalizing the Installation

Copy “C115.xla” to Excel’s “XlStart” folder

Test the installation by running Excel and noting whether “C-115 Electronic Reporting” has been added to the Tools pull-down menu.

Start Excel.  To test that the Add-in is available, select "Tools" from the pull-down menu. A new menu item “C-115 Electronic Reporting” should appear near or at the bottom of the menu.  If you don’t see this, try shutting down and re-booting your computer.  Once installed in the “XlStart” Folder, this new option will appear in every Excel spreadsheet. 

Note:  If you are running Windows 95, be certain to go to the "Tools" pull-down menu, select "Add-ins,” and check the “NM ONGARD C-115” Add-in from the list to activate it. 
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Program installation is now complete. Software upgrades will be posted to the Internet as they become available. 

Locating Files and Folders with Windows Explorer

Open Windows Explorer or Windows NT Explorer and follow the steps below.

Use "Find" to Locate Files and Folders
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From Explorer’s menu select “Tools” and “Find” “Files or Folders.” At the screen shown below, type in “XLStart” or “Template” as the file or folder name; select the drive you wish to search[(C:] in this case); select “Find Now.”   

The folder is found. If leading dots (….) appear under "In Folder" as shown, expand the “In Folder” window to view the complete path and make a note of the path.
Using Windows Explorer to Place Files into Folders

Using “Copy and Paste”

1. Use your left mouse button to highlight drive A:\ and note that “C115.xla” and C115Template.xls. files are listed (see illustration on the following page).

2. Select the “C115.xla” file; next select “Edit” from the pull-down menu and select “Copy.”  This action will copy the file to the Clipboard.
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3. Use Windows Explorer to locate the “XLStart” Folder. Highlight the folder. Select “Edit” from the pull-down menu and select “Paste.”  The file is now pasted from the Clipboard to the Folder.  If you double-click the “XLStart” Folder , you will see that the “C115.xla” file resides within the correct folder.
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Using “Drag and Drop”

1. Highlight drive A:\ with your mouse. 

2. Use your left mouse button to select “C115.xla” and, continuing to hold down your mouse button, drag the file to your “XlStart” Folder. Follow the same procedure with C115Template.xls, dragging it to the “Template” Folder. If these folders are several layers deep, using “Copy” and “Paste” as described above may prove easier.

NOTE:  If you are using a network you may need to get permission from your network administrator to do this.

The next section of the manual provides instructions on how to configure the Add-in Module to work with your template.

Section 2
Program Configuration 

Configuring the Report Add-in Module is fairly simple if you use the spreadsheet template provided with this package.  If you decide to use your own existing spreadsheet, the setup will be somewhat cumbersome and it will require that you pay very close attention to various settings.

[image: image14.png]C-115 Rows Processed
E-Report Rows Generated

Confirmation Sheet Rows

=0 All Done!




t
he C-115 spreadsheet template provided with this package is designed to look like a standard C-115 paper form. The Report Add-in included in this package is configured to work with the layout provided in the template below. To configure this Add-in requires that you have several pieces of information at hand (see requirements box at left).  Most of the examples in this section assume that you will be using the packaged template spreadsheet.  If this is not the case, you will have to identify the location of the required reporting information in your existing spreadsheet and reconfigure the Add-in’s “Column Settings” screen.

C-115 Spreadsheet Template
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Configuring the Add-in Module
For a first-time setup you will run Excel using the template file and save the output file as C:\C115TEST.TXT
The Add-in module is not difficult to configure if you follow the procedure outlined below. After the module’s initial run, many of the data items will be remembered automatically by your registry file. (Note:  If you reset the registry file, these items will return to their default values.) 

1. Start Excel.

2. From the “File” pull-down menu select “Open”

3. Browse for the file “Template.xls” and double-click to open it

4. Select “Tools” from Excel’s pull-down menu

5. Choose “C-115 Electronic Report” from the menu. When selected, the Add-in launches a dialog box, like the one illustrated below.  [image: image15.png]Move or Copy [21x]
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Information requirements for each tab are outlined on the following page. Note: Move from tab to tab, filling in the required information before clicking the OK button.  
On the C-115 Report Settings taB:
1. Enter your correct OGRID number

2. Enter a month

3. Enter a year (use four digits, any year is okay)

4. Enter the correct contact name and phone number

NOTE:  The information entered in this screen must match the information entered in your template Header fields.

On the Column Settings tab:

No changes are required if you are using the template file.  If you plan to use a pre-existing spreadsheet, see Section 3; you may need to change column settings.

NOTE:  You can avoid column reconfiguration if you use the template
[image: image4.png]C-115 Electronic Reporting Information

115 Rt et ConSetings | e |

Fool/Producing Froperty Column Days Produced ol [19.

AP Well Number ol Code 3 Colum [77
Code 1 Colum PaitofDisposion Colum [ 72
IectonVolume Colun Gas BTL/APIGraviy Colrn [ 73
Irecton resure Colamn Begining Di Storage Coturn [ 77
Code 2 Colum Dispostion Valume Colurn [ 75
01 Producion Colum Trarspote OGRID Colurn [ 75
Wate Producton Cokann Code 4 Do [77

Gas Production Column

Ending 0 Storage Colunn [ 75

[ Cancel





On the Output File Tab:
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Enter a report file name like “C:\C115TEST.TXT”.  This is your dummy output file that will place the configuration settings in your Windows Registry file. 

2. Enter a confirmation sheet file name like “C:\C115CONF.TXT”

3. Select OK. [Windows may ask you if you are ready to report to diskette A:\.  If you do not plan to save it to the external drive A:\ drive, you’ll need to change the file path to your desired destination drive.]  If everything works correctly, you should see a dialog box like the one below.  

 

Your dummy output file (C:\C115TEST.TXT) has now stored the configuration data in your Windows Registry file.  The next time you use the Add-in it will remember the OGRID number and contact information.  You will only need to enter the date information and whether or not this is an amended report.

NOTE:  To retain each month’s Report Data file, save it under a different name at the screen shown on the previous page (Output File tab).  If you decide to change the filename when you see the screen below and you click “Cancel,” the module’s action will cancel and you will have to run the report Add-in again.
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The next section describes in detail how to use the spreadsheet template and includes a list of common problems and their solutions.

Section 3
Using the Template 

The C-115 template is a simple Excel spreadsheet, but you do need to stay consistent in how you enter the data. (WARNING:    It is important to keep your report data for each month in a different Workbook because the Add-in takes data from ALL of the Worksheets in the current Workbook.)
T
he spreadsheet used in this program is simple; all you are required to do is enter the correct data in the appropriate column.  If you are reporting on a fair number of wells, you may need to add more worksheets to your template.  To save time and to ensure that all your worksheets are processed correctly, change the Operator Headings in your template before you add more worksheets.

Adding Worksheets to the template Workbook

With your template open in Excel

Select “Edit” from Excel’s pull-down menu (or right-click your mouse) and select “Move or Copy Sheet.”  In the pop-up window like the one shown, click the box “Create a Copy” (lower left-hand corner of the window) and highlight (move to end); click “OK.”

You now have a new worksheet into which you may enter data.  Repeat this procedure as many times as needed. Remember that worksheets must remain in 1,2,3 order, starting from the left of the Workbook.  Excel reads data from left to right, so any discrepancies in sheet order will produce a corrupt data file.  If you don’t highlight (move to end) before clicking OK, Excel will place your new worksheet out of sequence; grab the tab with your mouse and drag it to the appropriate position.

Entering Data to Your Customized Template

Each of the columns processed by the electronic reporting Add-in are briefly described below. For the Add-in to work correctly you must follow the reporting conventions described below and you must also change the information in the Operator Headings.

Column A

This column should remain blank. No data is required in column A.

Column B

1. Enter the 5-digit pool number followed by the pool name (in the same cell); use both uppercase and boldface.  

2. In the next row enter the 6-digit producing property ID followed by the property name (in the same cell) (leading zeros are important), this time use lowercase and bold face.  

3. In the next row enter the well number followed by the unit letter-section-township-range (U-L-S-T-R) location for the well.

4. In the next row enter the well’s API code (dashes are important).
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Repeat steps 3-4 for each well within that property ID.  Repeat the entire procedure for each different Pool and Property ID.

Column B – “Code 1” (Well Status)

Enter one of the following acceptable entry codes:

1. (F) Flowing
         5.  (T) Temporarily Abandoned


2. (P) Pumping
         6.  (I) Injection Well


3. (G) Gas Lift
         7.  (D) Salt Water Disposal Well

4. (S) Shut-in
         8.  (A) Plugged and Abandoned

Column D - Volume

Enter the number of barrels of water or MCF of gas injected. This requires clarification on type of entry (e.g., 5 BW or 10 MCF).

Column E

Enter the injection pressure (PSIG).

Column F - “Code 2” (Type of Injected Fluid)

Enter one of the following acceptable entry codes:

1. (W) Water

2. (G) Gas

3. (C) CO2
4. (O) Other

Column G

Enter the number of barrels of crude oil or condensate produced for the month.

Column H

Enter the number of barrels of water produced for the month.

Column I

Enter the MCF of gas (includes CO2) produced for the month.

Column J

Enter the number of days that the well produced during the month.

Column K - “Code 3” (Type of Product)

Enter one of the following acceptable entry codes:

1. (G) Gas (includes CO2)

2. (O) Crude Oil, Condensate, Drip

3. (W) Water

Column L

Enter the point-of-disposition (POD) number (7-digits) for each product transported from the property or enter the non-transported volume that effect oil storage balance.

Column M

Enter the gas BTU in effect for the gas volume transported (adjusted to 15.025 PSIA at 60o F) or enter the weighted average API oil gravity of oil transported.

Column N

Enter the beginning oil storage volume for the current reporting month.

Column O

Enter the volume of oil, gas, or water transported or otherwise dispositioned (lost, vented, spilled, used on property, etc).

Column P

Enter the transport OGRID number. 

Column Q - “Code 4” (Non-transported Disposition)

Enter one of the following acceptable entry codes:

For oil:

1. (C) Circulating Oil

2. (S) Sedimentation

3. (L) Lost

4. (T) Theft

5. (O) Other

For Gas:

1. (G) Gas Lift

2. (R) Repressurizing

3. (V) Vented

4. (U) Gas used on property

5. (L) Lost

6. (O) Other

For Water

1. (I) Water re-injected on property

2. (P) Pitted

3. (A) Evaporated

4. (O) Other

Column R
Enter the ending oil storage volume.

Remaining Columns 

No data is required in the remaining columns.

Creating and Submitting Your C-115 Report 

When you have completed entering data into your template, run the Add-in to create the “Flat File” for transmission to OCD using the following procedure:

1. With your final template open, go to the “Tools” pull-down menu; select C115 Electronic Report:  OGRID, Report Month, Report Year, Contact Name, and Phone must match your Template Headings for the month/year you are reporting. If you are filing an Amended report, contact the OCD directly for information on filing amended reports.


2. Move to the Output File Tab (as shown below) and enter the correct file name(s).  If you intend to save a separate file for each month’s output, choose a file name that reflects the month for which you are reporting; otherwise, you can simply overwrite the file. 

3. Click OK.  You will see a screen like the one below indicating that the module is running the Add-in.

4. Click the Exit button.  Locate your Output data file (saved either to your hard drive or to diskette).  A sample Output file is shown on the following page.
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Sample Output (Flat) file.  This is the file you will send to the OCD.

The easiest way to submit your report is to attach the file to an electronic mail message (e-mail) and send it via e-mail to nmc115@state.nm.us.  Most e-mail programs support file attachments but if yours does not, copy the file to a 3.5” diskette and mail the diskette to: 

C-115 Electronic Filing

Oil Conservation Division

NM Energy, Minerals and Natural Resources Department

2040 S. Pacheco Street

Santa Fe, New Mexico 87505 

Common Problems 

The Add-in package is not particularly sophisticated in how it processes data in your spreadsheet, so you may experience some problems.  Some of the more common problems encountered are noted on the following page.  Please use this guide to troubleshoot errors associated with your file.  If you are still baffled and need help, contact Annette Carroll or Martha Cather of the PRRC at the phone numbers or e-mail addresses provided in Section 1, page 1.

Template Troubleshooting Guide

	Problem
	Solution

	Nothing happens when I press the OK button on the Add-in.
	One of the data fields in the Report Settings screen is not filled out correctly.

· Check that you are using 4 digits for the year.

· Verify that the column numbers specified for each of the data items on the Column Settings tab match those in the spreadsheet.

	How do I know if the correct data has made it into the transmission file?
	Examine the Confirmation output file you created with the Add-in and saved to your floppy disk or elsewhere on your hard drive. 

	Why does the Add-in find so many rows to process?
	The Add-in reads every row in each worksheet contained in the currently open Workbook. Excel usually creates at least three worksheets per Workbook.

	Can I use other columns in the worksheet for other purposes?
	Yes, but don’t use the columns specified in the Column Settings of the Add-in for any other type of data.

	My data file contains xxx’s and yyy’s and my Confirmation sheet does not look correct.
	Your worksheets may be out of order. If you have several worksheets in your workbook, they must follow in 1,2,3 sheet order, starting from left to right.  Reorder them if necessary.

	I get a Windows Run Time error 91…… when I try to process the data sheet.
	This message usually indicates a programming error.  Check your worksheet to confirm that you have entered the data correctly (see data entry instructions found in this section).  Check that the information found in your Report Settings Screen of the Add-in Module matches your Template Operator Headings (e.g., month and year must match in both).  These entries will change each month and they must match in both locations.

	I’m told my test file did not come through correctly for processing through the OCD’s ONGARD system.  What did I do wrong?
	Check the formatting on your data entries.  Specifically, review the steps listed for Column B. Extra spaces in front of Pool or Property ID’s can sneak in and cause problems.


If you encounter other problems or find solutions to problems that are not included in this list, please notify us.  We welcome your input in helping us better serve current and future users of this software.

Hardware Requirments


IBM 486/Pentium or compatible


3.5” Floppy Drive


VGA/SVGA monitor


16MB RAM (recommended)


33.6K modem (recommended for e-mail submission)








software Requirments


MS Windows 95/98 or NT 4.0


MS Excel 97/98 or newer 


Internet e-mail software                   (for Internet submissions)


Internet access software                   (for Internet submissions)
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required


information 


OGRID number


Contact name


Contact phone


The columns in your spreadsheet that contain the required  data (if NOT using the template)


Name of output file








Common


Problems 








Double-click bold items and enter replacement data for Pools, Properties, Wells, etc.











NOTE:  After the initial setup, saving a Confir-mation Sheet to disk each month isn’t necessary, but it’s a quick way to check whether the Add-in has correctly processed data from your spreadsheet.  Uncheck the box if you don’t wish to save the file.
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